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HardingFPA-X User's Manual
Thismanual details how to use the HardingFPA-X system from a Client computer.

For HardingFPA-X Version 4.0

Documentation date: 17/10/2014.
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Overview
The HardingFPA-X System is a distributed version of the HardingFPA Flash and Pattern Analyser. It

operates in a similar way, but analyses file-based workflows instead of tapes.

This manual describes the use of the client-side components in the HardingFPA-X System. These are

intended for users to submit jobs and view the results of analysis, while the system takes care of the

analysis, possibly on a different computer on a local area network. This manual does not include detailed

installer/administration instructions for the system. These can be found in the HardingFPA-X

Administration Manual.

The client-side of the HardingFPA-X System consists of two applications, namely HardingFPA-X Submit

and HardingFPA Viewer. These can be found in Applications→ HFPA-X on OS X, and in the Start Menu

under HFPA-X onWindows.

Jobs can be submitted using the Submit application or by dropping the movie files into watch folders (see

your administrator to find out if you have watch folders enabled and where they are). These jobs are then

posted via the central database into the Job Queue, where they are picked up byAnalyser computers

which analyse the material and write out results files which may then be viewed using theHardingFPA

Viewer.

This manual covers both the OS X and Windows versions of the HardingFPA-X Submit and

HardingFPA-X Viewer, which operate in an identical manner.
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Licensing
Your administrator must have licensed your computer and username to run the HardingFPA-X Submit

application. If you are not licensed, you will see the following error dialogue box:

From this dialogue box, the administrator may click "Yes" to license either your username or all users on

your computer by entering the administrative password, shown below. The default password for this can

be found in the HardingFPA-X Administration Manual:

The HardingFPA Viewer does not need to be licensed.
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Movie Files
The system will open and attempt to analyse anymovie file for which the computer it is installed on has

the codec. There are number of codecs included (see below). Any further codecs required will need to be

installed on the computer(s) running the application.

Only movie files with the following extensions will be analysed:

*.avi, *.mov, *.mpg, *.mpeg, *.m2v, *.mp4, *.vob, *.wmv, *.mxf, *.flv, *.qt, *.ps, *.3gp, *.mkv,

*.m2ts

In general, if the file can be viewed correctly using QuickTime (or WindowsMedia Player) on the computer

that the application is running on, and is within the accepted limits for frame size and frame rate (see

below), then the application will be able to analyse it.

The list of accepted frame sizes and frame rates are as follows:

Legacy SD analysis frame sizes:

320x240, 352x288, 384x288, 640x480, 640x486,

702 – 720 x 480

702 – 720 x 486

702 – 720 x 576

768x576

Legacy SD analysis frame rates:

25, 29.97

Version 3 SD analysis frame sizes supported:

320x240, 352x288, 352x240, 384x288, 480x360, 640x360, 960x540  640x480, 854x480, 640x486,

854x486,
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702 – 720 x 480

702 – 720 x 486

702 – 720 x 576

768x576, 1024x576,

Version 3 HD analysis frame sizes supported:

960x720, 1280x720, 1440x1080, 1920x1080

Version 3 analysis frame rates:

24, 25, 29.97, 30, 50, 59.94, 60

Version 4 UHD analysis frame sizes supported (only available with 4K licence enabled):

Ultra high definition television 3840 × 2160 1.78:1 (16:9)

DCI 4K (native resolution) 4096 × 2160 1.90:1 (19:10)

DCI 4K (flat cropped) 3996 × 2160 1.85:1

Version 4 analysis frame rates:

24, 25, 29.97, 30, 50, 59.94, 60

The HardingFPA-X uses the following frameworks to access video frames:

l FFmpeg

l QuickTime

l DirectShow (onWindows only)

When presented with a file, a framework is selected based on the movie file extension.

MXF Files
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An attempt is made to open the MXF file using the internal MXF library. This library has support for OP1A

and OP ATOM wrapped MXF files with the following codecs:

l DV

l DVCPRO

l DVCPRO HD

l DNxHD

l AVC Intra

l IMX 50

l AS11 (DPP)

If the internal MXF library does support the MXF file format, then the FFmpeg library is used to decode

these frames. The MXF library includes support for AVIDMXF files as well asMXF time code tracks.

If the MXF file format is not supported by the internal MXF library, an attempt is made to use the FFmpeg

library to open the file directly.

OnWindows platforms, if all else fails an attempt to use DirectShow (using any codecs installed in the

system) will be made. If this is successful, an attempt will be made to use the VITC information, if any,

embedded in the video material.

MOV Files

The QuickTime library will be used to open QuickTime files. File support depends on the QuickTime

codecs that are installed on the computer used for analysis. The QuickTime library supports QuickTime

timecode tracks. The system does not support multi-track QuickTime movies.

Other Files

Firstly the use of FFmpeg is attempted, followed by an attempt (onWindows platforms only) to use the

DirectShow framework, and finally the QuickTime framework.

Why use FFmpeg?

l FFmpeg provides a uniform set of embedded codecs that allow for consistent results across dif-

ferent platforms and installations.
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l If a previous version of the application used DirectShow or QuickTime, and a newer version uses

FFmpeg, there is a possibility that the results will differ due to the slight differences between codec

algorithms. The use of FFmpeg in current and future versions of the HardingFPA product range will

mitigate this problem.

l FFmpeg in many cases removes the requirement of purchasing 3rd party MXF support and codecs

as the MXF library, in conjunction with FFmpeg, now fulfils this requirement.

The FFmpeg library supports the following codecs:

D10 (IMX), DV, DVCPRO, DVCPROHD, DNxHD, MPEG1VIDEO, MPEG2VIDEO, H261, H263,

RV10, RV20, MJPEG, MJPEGB, MPEG4, MSMPEG4V1, MSMPEG4V2, MSMPEG4V3, WMV1,

WMV2, H263P, H263I, FLV1, H264, INDEO3, VP3, THEORA, ASV1, ASV2, FFV1, MSVIDEO1,

SNOW, XVID, FFVHUFF, INDEO2, FRAPS, VP5, VP6, VP6F, FFH264.

The decision tree that is used to decide which framework to use is shown in the flowchart below:
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Version 3 Analysis Algorithms
HardingFPA software now features new analysis algorithms, which are better tuned to High Definition and

File-based work.

The Version 3 analysis algorithms are better suited to accommodate subtle changes in the image data,

and provide much closer results when testing the samematerial repurposed either into a different video

format, or encoded with a different codec. The main differences between the legacy algorithms and the

Version 3 algorithms are detailed below:

Different Graph Scaling

The HardingFPA generates risk values using the same range as its predecessor (i.e. 0 to 3.4) but displays

the graphical data using a revised vertical scale. This modified scale allocatesmuch more vertical space

for risk trace warnings and diagnostic trace steps but only displays risk traces up to the value of 3.0. Risk

traces values from 3.1 to 3.4 are still logged as part of the results files but are graphically displayed capped

at 3.0.
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(left) Version 2 and (right) Version 3 Graphing

The Squiggle

The HardingFPA gives enhanced visual diagnostics when an incoming transition coincides with an

outgoing transition from one exactly second earlier. The Version 3 algorithms insert a squiggle (see below)

to indicate when the diagnostic trace has simultaneously gained and lost a transition over the most recent

second between video frames.

Analysis Results

The Version 3 algorithms give results which are broadly similar to those generated by version 2.5. The

figure below shows the results of both versions when analysing the same video input under the same

guidelines:
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However, the results between the two versions will not be identical. The Version 3 algorithmswill, in

general, be more slightly more lenient to complex, rapid motion:
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... but more strict to examples of powerful, localised flashing:
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Most importantly of all, the Version 3 algorithms have been designed to be as format-agnostic as possible.

Changes in file formats or codecs will alter the underlying video data even if these changes are not visually

apparent. Here, the same video has been encoded at the same resolution using two different codecs. The

absolute differences between the two images are shown in the third image as deviations from mid grey.
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The Version 3 algorithms generate highly consistent results from different image resolutions and frame

rates. Here, the samemovie has been analysed in 720x576i50 and 640x480i60 formats. The only

noticeable difference is in the horizontal graph scale due to the different frame rates.

The graph below shows three sets of luminance flash risk results of the samemovie analysed in SD-

576i50, HD-720p50 and HD-1080i50 formats, and highlights the considerable similarities in the results:



Cambridge Research Systems Ltd.

Page 16 of 55



Cambridge Research Systems Ltd.

Page 17 of 55

SD Legacy Mode
The HardingFPA has a version 2.5 legacy analysis option for when comparisons with earlier HardingFPA

analyses are necessary (i.e. those that have come from versions 1.x of the HardingFPA-X, and to have

some level of compatibility with HardingFPA V2.5x SD-SDI Standalone tape-based systems).

If this has been enabled, it will be apparent in both the results graph interface and the generated PDF

certificate (see below).
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Subliminal Event Analysis
If enabled in the Settings, the system will test the incoming material for potential subliminal frames at the

same time as it is analysing for the usual flash and pattern criteria.

These frames will be identified on the graph visualisation as yellow circles, shown in the example below. A

yellow circle below the PASS/FAIL line indicates a subliminal warning, and one above the line indicates a

subliminal failure.

The appearance of the subliminal results can be switched on and off in the usual manner, by clicking on

the Subliminals yellow circle in the top-right corner of the graph.

What is a Subliminal Event?

The insertion of an image (or images) with contents different from the preceding or following images which

is too short for the viewer to be consciously aware of. The duration of a subliminal event is user-

configurable. The default settings are currently up to 0.05 seconds for a subliminal failure and up to 0.2

seconds for a subliminal warning. A subliminal event may be inserted at a scene change as it is not
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necessary for the images preceding and following the subliminal event to be similar. Additionally, a

subliminal event may involve inserted text or a change to only part of the image.

It is important to note that a subliminal event must contain information. An inserted blank image that is

black, white or uniform grey does not mean anything, and is therefore not regarded as subliminal.

Examples of subliminal and non-subliminal events

Example 1

This is a subliminal event because of the inserted images. The blue border in the 7th image shows the end

of the subliminal event.

Example 2

This is a subliminal event because of the inserted picture of a person's head. The blue border in the 7th

image shows the end of the subliminal event.

Example 3

This is a subliminal event because of the inserted text. The blue border in the 7th image shows the end of

the subliminal event.

Example 4
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This is not a subliminal event because the inserted images are just the inverse of the preceding and

following images and therefore contain no new information.

Example 5

This is not a subliminal event because the inserted images contain no information.

Example 6

This is not a subliminal event because none of the images contain any information.

Example 7

This is a subliminal event because the inserted images contain information. The blue border in the 7th

image shows the end of the subliminal event.

Example 8

This containsmore than one subliminal event as shown by the blue border images.

How does the HardingFPA Detect Subliminal Events?
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The HardingFPA searches for two sudden uncorrelated changes which occurred at different times but at

the same position in the image sequence. Changes which are blended in over several frames are not

considered as potentially subliminal as they would be consciously noticed by the viewer.

The HardingFPA can log the occurrences of two sudden uncorrelated changes and issue a subliminal

event or a subliminal warning depending on its duration. These are indicated as yellow dots above and

below the failure line respectively and are indications of where subliminal insertionsmay have occurred.

It is important to note that the HardingFPA may issue a large number of subliminal failures or warnings

especially when analysing rapidly flashing imagery. This does not necessarily mean that the video contains

a large number of subliminal insertions but merely that the HardingFPA has detected a large number of

potential candidates. It is ultimately up to the user to verify whether these flagged events constitute

subliminal insertions or benign uncorrelated changes.

Why does the HardingFPA indicate a subliminal event one frame after it has occurred?

The HardingFPA needs to detect the start and end times of any potential subliminal insertion to determine

whether the effect was rapid enough to be viewed subconsciously. Therefore, the HardingFPA can only

log a subliminal event after it has disappeared.
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HardingFPA-X Submit
The HardingFPA-X Submit is the main application on the client side of the system. From this application

you can submit jobs, view the job queue, see all completed jobs, view the PDF certificate and graphical

depictions of the results. The Submit will automatically launch the Viewer application for results viewing.

There are two ways to submit jobs to the system for analysis, manually (See "Submitting Jobs" on page

27)and automatically (See "Watch Folder Support" on page 28)

User Interface

The interface of the HardingFPA-X Submit is split into two tabs. The Job Queue (described below) lists all

of the currently pending jobs in the system, and the Completed Jobs list shows all of the completed jobs

for the last 14 days.

The Job Queue displays the jobs in the order in which they will be analysed (although some analysersmay

be set to only analyse jobs of a certain length, so this may not be the exact order). If jobs appear to be out

of order by Job ID, it may be that the administrator hasmodified the priorities of one or more of the jobs in

the queue. Job prioritiesmay only be changed by administrators. Double-clicking on a job in the Job

Queue will launch the Viewer application in order to view the results as they are being analysed.

If the setting is configured in the Settings screen, you may clickShow jobs submitted by all user in order

to see all jobs in the system. If this is not checked, or has not been checked by your administrator then you

will only be able to view jobs that were submitted using the Submit using the computer/user name

combination that you are currently logged in as. Please note that this filter only applies to jobs submitted

with the Submit application, and not those that you have dropped into watch folders.

ETA to next job shows the estimated waiting time until your first job in the list will be analysed. If you do

not have any jobs in the Job Queue, the ETA shows the estimated time for all of the jobs in the Job Queue

to be completed. The format of this time is hours : minutes : seconds.

On both tabs there are two buttons, Refresh and Submit Movies. Refresh can be used to force a refresh

of the current tab. Submit Movies is used to enter new jobs into the Job Queue.
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Settings

It is important to make sure the settings are correctly configured before starting to use the Submit

application, otherwise the jobs submitted will not be analysed, and it will not be possible to view the job

database. The settings screen is found by clicking Tools→ Settings and is shown below.

You may only have read access to these settings if you are not running the application as an administrator

user. If you need to change the settings, either run the Submit as an administrator user or contact your

administrator.

The settings are separated into three tabs, Database, Locations andResults.
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Database

The Database Settings describe the host name and port of the HardingFPA-X database, which contains

all of the information required for the system to operate, including the list of jobs.

Host Name can be either an IP address or the computer name. Please obtain this information from your

administrator.

Host Port is the port that the database is running on. Please obtain this information from your

administrator.

Auto Refresh selects whether you would like Submit to refresh the tables automatically, and at what time

interval (the minimum interval is 5 seconds).
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Be aware that if these settings are modified, the Submit will need to be restarted for the changes to take

effect. Additionally, if these settings are set incorrectly, the Submit may take a longer time than usual to

start up as it looks for the database

Locations

The Locations Settings describe the locations of the movie and results files.

Root Path: This is the location of the root of your storage system. This folder will typically be the root of

the SAN or shared network drive where your media is kept. This is the mount point that refers to that

location from the current computer only, and might be different on different computers. Please contact

your administrator if you do not knowwhat this should be set to.

Results Folder: This is the location where the Analysers in the system write the results to. This is required

for the Submit application to automatically launch the Viewer to view the results of movie analysis.
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Temporary Storage Folder: This is an optional location where any submitted movie files will be copied to if

they cannot be found in the root path. This must be within the root path, and must be writable by the user

that the Submit is running as.

Watch Folder:This specifies a folder in which to continually watch for movies, and automatically submit

any that appear.

Analysis Options (forWatch Folder only): This specifies the Analysis Standard used for any video files

placed in theWatch folder and whether the Test Type isNormal for the whole video image, orCentre

Cutout or for 3D analysis depending on the options purchased.

Results

The Results Settings allow the settings to be modified for the generated results files and other results

related options.
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Analysis Results Storage: This is the default setting for when to create HardingFPA Results files

(PAP,PAR and PAM).

XMLReport Settings: This is the default setting for when to create XML Results files.

PDF Report Settings: This is the default setting for when to create PDF Reports, and what detail to

include in them.

TheDouble Click on Completed Job setting defines what you would like to happen when you double-click

on a completed job in the Completed Jobs tab.

TheOptions section features the options:

Enable Submit to view jobs from all users, which must be checked in order to allow the application to

show jobs from other users in both the Job Queue and Completed Jobs tabs. If this is not checked, or has

not been checked by your administrator then you will only be able to view jobs that were submitted using

Submit on the computer and user name combination that you are currently logged in as.

"Automatically open Viewer when job starts analysing, which will open the Viewer software as soon as a

job in the Job Queue becomes busy, to allow you to view the analysis process.

Submitting Jobs

In order to submit a new job, click on the Submit Movies button. A Submit Movies dialogue will appear.

From this you may browse to the file(s) you wish to submit as jobs. Multiple file selection is supported.

After selection, the following screen appears, and you may enter any additional information for the job,

and (depending on licence) select the Analysis Standard and additional options. When all the information

has been entered, click OK.
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If the movie files chosen are not located within your Root Path, an attempt is made to copy the files to the

Temporary Storage Path for analysis.

The Analyser computers will analyse anymovie file for which the computer it is installed on has the codec,

otherwise the Analysers will dismiss the job. If in doubt, contact your administrator.

Watch Folder Support

Submit supports its own watch folder settings for ease of integration with editor's workflows. (The settings

for which can be set up in the settings screen (See "Settings" on page 23).

If this location is set, then anymovies that are copied into the watch folder location are automatically

submitted, with default names and with the settings specified.

Once a movie file has been submitted and analysed through the watch folder, it is not re-submitted again

until its modified date and time changes.

Aborting Jobs

When using the Submit, you may abort any jobs that you have submitted yourself.
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On the Job Queue tab, highlight the job you wish to abort and click .

If the job is currently analysing, the analysis will be stopped, otherwise it will be set to the aborting status

and disappear after a fewminutes.

Viewing Results

Submit is able to launch the Viewer to view the results of analyses that are currently busy analysing or

have finished analysis.

To do so, double-click on a job either in the Completed Jobs list or one in the Job Queue that is busy.

You may view the results of a completed job by right-clicking on the job line in the Completed Jobs table.

The context menu shown above will then be displayed. View Results will launch the HardingFPA-X Viewer

in order to see the graphical depiction of the results, and View PDF will launch a third party PDF viewer to

view the PDF certificate. These actions can also be tied to the double click action by selecting the option in

the Settings screen. TheResults Folder setting must be set correctly for this to work.

Interpreting the PDF

Test Certificate Page

(The following is an example, and details may vary)...
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Video Standard – This summarises the number of video lines, whether the video is progressively

scanned or interlaced and the frame (or field) rate per second. For example, a 576i60 video standard

denotes 576 video lines with interlaced fields at 60 fields per second whereas 576p30 denotes 576 video

lines with progressive frames at 30 frames per second. A frame represents a whole video image whereas

a field represents even or odd lines in a video image.

Video Scan – This will be blank if the video is progressively scanned or will state “upper (or lower) field

first” if the video is interlaced. The HardingFPA will state “assumed” upper (or lower) field first if the video

field order flags were not detected or not present. The assumed field order is derived from default field

orders for the specified video standard.

Frame Dimensions – This represents the width and height of the video picture in pixels. Please note that

all video feeds are resized and analysed in 16:9 format regardless of input video dimensions.

Active Area – Showswhich area of the frame was analysed to generate the results.

Summary of Results – This summarises the number of failed frames according to Red flash, Spatial

pattern and Luminance flash analysis plus a log of extended failures. The latter occurs when flash analysis

persists close to failure for several seconds. The HardingFPA will only generate a pass if there are no

failed frames in any category.

Analysis Results Pages
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RED – The results of red flash analysis in the range of 0.0 to 3.4. A value of 0.3 or 0.4 indicates a warning

while a value of 0.5 and above indicates failure. The number which follows in brackets represents the

number of transitions to or from a saturated red which have occurred in the most recent second.

SPAT – The results of spatial pattern analysis in the range of 0.0 to 3.4. A value of 0.3 or 0.4 indicates a

warning while a value of 0.5 and above indicates failure.

LUM – The results of luminance flash analysis in the range of 0.0 to 3.4. A value of 0.3 or 0.4 indicates a

warning while a value of 0.5 and above indicates failure. The number which follows in brackets represents

the number of luminance transitions which have occurred in the most recent second.

X – The presence or absence of an extended failure condition. This column will either be blank or will

contain an “X” symbol to indicate when an extended failure condition has occurred. An extended failure

occurs when luminance or red flash analysis generates warning values of 0.3 or 0.4 for at least 80% of the

most recent 5 seconds.
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IMAGE – The image column will normally contain the first and last images of the failed sequence. If the

failed sequence is too short to display both images, only the first image will be displayed. If the failed

sequence is longer than an entire page column, the first and last images for that column will also be

displayed.
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HardingFPA Viewer
The HardingFPA Viewer is used on the client side computers of the HardingFPA-X System in order to

view the results for completed analyses. It is typically launched via the HardingFPA-X Submit application,

by Right-clicking on a completed job and selecting View Results, but may also be launched separately – in

which case results files (PAR, PAP and PAM) may be opened using the Open File button or menu item

(located under the File menu).

The Main Screen

The HardingFPA Viewer screen displays a graphical representation of the characteristics of the analysed

clip, and some additional advanced diagnostic information. This allows the user to quickly and efficiently

view the locations of failures or cautions in the source material, and optionally play back the areas around

these failures to aid in rectifying the offending material.

Once a set of results (PAR, PAP and PAM files) has been opened with the HardingFPA-X Viewer, the

screen will appear similar to that displayed below. A timeline is displayed at the bottom of the screen

detailing the timecodes of the corresponding frames and whether the frame is a failed frame. Failed
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frames are surrounded in blue. Please note that images are only displayed in certain circumstances

around failure/caution regions and if no image is present then the frame will contain the text “No Image”.

A large version of the thumbnail at the current cursor position is shown on the top left hand side of the

screen.

The results can be browsed either by dragging the graph display left and right or bymoving the scroll bar

located at the bottom of the screen. Clicking the left and right cursor keys will move the results one frame

at a time.

To the right of this scroll bar there are two buttons which will move the cursor to the next or previous

failure.

The View Menu
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Within this menu are the options to zoom the graph in and out in order to focus on certain areas of the

results, as well as the options to show or hide the diagnostic traces and the caution band from the graph.

Zooming in and out may also be performed by the Zoom In and Zoom Out buttons underneath the graph

or by pressing F1 and F2. The Material Description can also be viewed here.

Analysis Information

The table on the left hand side of the screen contains two tabs which display diagnostic information about

the clip. The Analysis Summary tab shows the following pieces of information, which are applicable to the

entire clip:
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Status: Showswhether the HardingFPA-X is reviewing results or in another state such as

loading/results/analysing/not loaded etc.

Video Source: The video standard of the analysis being viewed.

Filename: The filename or title of the source that was analysed to obtain the results currently being

displayed.

Analysis Timecode: The timecode of the final frame in the clip. This is expressed in hours : minutes :

seconds : frames.

Marked Length: The length of material currently marked off with Begin and Endmarkers. This is

expressed in hours : minutes : seconds : frames.

Recorded Length: The total length of the clip expressed in hours : minutes : seconds : frames.

Analysis Status: The Pass / Fail status of the clip with respect to the currently selected Flash and Pattern

guidelines.

Luminance Flash: The number of incidents and frames that have exceeded the test guidelines for

luminance flash.

Red Flash: The number of incidents and frames that exceed the test guidelines for red flash.

Spatial Patterns: The number of incidents and frames that have exceeded the test guidelines for spatial

patterns.

Extended Failure: The number of incidents and frames that exceed the test guidelines for extended

failure. This represents the number of frames for which the black trace has appeared or equivalently, the

number of times that the maximum allowed number of flash warnings (levels 0.3 or 0.4) in the most recent

5 seconds has been exceeded.

In addition to this information, there is a second tab featuring Advanced Information. This tab contains

detailed information corresponding to the individual frame at the current cursor position, and may be of

use in determining the build up to a failure. The items described are as follows:
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Luminance Diagnostic: This is the numerical value of the diagnostic plot shown on the graph. It

represents the minimum number of transitions which the most active 25% of the image frame has seen in

the most recent second.

Luminance Flash Area: The percentage area of the image frame which has exceeded the Flash

Guidelines.

Luminance Flash Contrast: The average contrast of the area of the image frame which has exceeded the

Flash Guidelines.

Extended FlashWarnings: The number of image frames which have generated flash warnings (levels 0.3

or 0.4) in the most recent 5 seconds.

RedDiagnostic: The number of red transitions which the most active 25% of the image frame has seen in

the most recent second.

Red Flash Area: The percentage area of the image frame which has exceeded the Red Flash Guidelines.

Red Flash Contrast: The average amplitude of flash to and from saturated red of the area of the image

frame which has exceeded the Red Flash Guidelines.

Spatial Pattern Area: The percentage area of the image frame which has exceeded the Spatial Pattern

Guidelines.

Spatial Pattern Contrast: The average contrast of the area of the image frame which has exceeded the

Spatial Pattern Guidelines.
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In optional 3D analysis mode, the HardingFPA-G2 has a third results tab detailing the number of failed

frames for each video channel:

Frame Masks

The results include visual information in addition to the results images in the form of FrameMasks. These

mask images are overlaid on top of the frame images on the large image in the top-left of the main screen

and depict the locations of problem areas in the sequence, to aid in the repair of failing sequences.

When the results first appear on the graph, the large image in the top left hand side will appear as usual. In

order to utilise the framemask images, Click on the FrameMaskmenu, and select the type of failure that

you want to see the mask overlaid for:

When any of the framemasks are chosen from this box, the images will change and the mask will be

overlaid onto a darkened, black-and-white (monochrome) version of the original frame image. A frame will

appear around the image to depict the currently selected mask. An example is shown below:
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The colours represent the number of transitions which each pixel has experienced in the most recent

second after allowing for motion. The analyser will issue a failure when more than one quarter of the

image contains red or purple pixels. The same colour coding (shown below) is used for both luminance and

red flash analysis.

Pixel Colour Number of Transitions

none 0

green 1 or 2

yellow 3 or 4

orange 5 or 6

red 7 or 8

purple 9 or more

The spatial pattern mask data logs the activity which exceeds the spatial guideline limits as shown below:
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The mask data appears as a set of uniformly coloured tiles in the image which represent how long they

have persisted in the image sequence. Spatial mask data only appears for stationary, regular patterns

which lead to failure. Any spatial patterns which drift, or are not regular, or do not persist in the video long

enough to trigger a failure are excluded.

Pixel Colour Persistence

none no regular stationary pattern present

green 0 to 1/6 second

yellow 1/6 to 1/3 second

orange 1/3 to 1/2 second

red more than 1/2 second = FAILURE

purple outside of pattern regularity limit

The actual colours used represent how close the spatial pattern is to causing a failure rated in terms of how

long the pattern has persisted in the image sequence. When running under Ofcom guidelines, the

HardingFPA will only tolerate illegal spatial patterns to persist for up to half a second -- any longer than

this will lead to a failure. Therefore the green, yellow and orange colours denote the build up to failure

while red represents the actual failure itself. Purple is reserved for tiles which are part of the detected

spatial pattern but whose pattern characteristics lie outside of the allowable range when compared with

the rest of the spatial region. These purple tiles do not represent persistence and can accompany spatial

masks of any colour.

It is important to note that the HardingFPA only presentsmask colours for pixels whichwill go into

failure. This allows the editor to focus on the region(s) of the image which lead to the failure rather than

flooding the user with unnecessary information. As a result, many images will contain no masked /

coloured pixels even though there may be some flash or pattern activity occurring. However, all luminance

and red flashing activity is exposed in the mask data if an extended flash failure is either occurring or is due

to occur wihin the next 5 seconds.

In addition, framemask activity may suddenly disappear after an isolated failure sequence if the remaining

pixel transition activity does not lead to a subsequent failure.

Saving a Selection

It is possible to save the marked selection of results as a separate set of files in order to make transferring

them easier. Set marker positions by either right-clicking on the graph or pressing the Page Up and Page
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Down keys or by clicking on Set Results Start and Set Results End in the Results menu:

In the File -> Save Results menu, the Save Selection As... item can be found. Click this and the

following screen appears allowing the selected region to be saved.

Images can be saved a configurable number of seconds around failures, and images can be omitted if the

material passes (by checking the boxOnly if material fails). Note however that if the currently loaded

results set does not have all images, then selecting All Images will only be able to save images where they

exist on the currently loaded results.

Interpreting Results

It is important to note that material re-encoded at a different frame rate, will usually have a different

number of failed frames, and the results may differ because of the extra or missing frames that were

introduced during the conversion process.
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The following items are phenomena commonly seen in the results along with explanations for the

behaviour.

1) A flash occurred but the normal flash risk trace didn’t appear – The main flash risk trace (dark

green line) may not appear if flashing is less than 20cd/m2 in contrast or if the flash frequency is

significantly within guideline limits. Remember that 2 opposing transitionsmake up a single flash.

The example below shows that two transitions have been detected by the diagnostic trace (light green line)

but that the main risk trace has not yet appeared because the flash frequency up to this point is not

considered to be significant.

(1) Showing a flash but no flash risk trace

2) The flash risk trace (dark green line) appeared close to the pass-fail limit for a long sequence

of images but didn’t enter the fail zone – The system has detected flashing of above 3Hz and

20cd/m2 in amplitude; but the flash area is less than 25% of the screen area.  If the criteria for failure are
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not all met then the system will generate a line based on how close the material is to failure.  If the line is

hovering just below the failure line then it might only need a tiny change in size of the flashing area to push

it into failure.  Such a tiny change could be introduced when converting between formats, frame rates or

codecs if this is not done carefully using professional grade codecs.

The example below shows that the flash risk has remained close to the failure line for long enough to

generate an extended flash failure. This occurs whenever more than 80% of the frames in the last five

seconds generated flash risk warnings of 0.3 or 0.4 (i.e. close to failure).

(2) Long sequence of flashing that eventually led to an Extended Flash Failure

3) The flash risk trace (dark green line) persists for several frames after a flash occurred – This is

perfectly normal, and arises because of the way the system has to detect flashing frequencies over the

most recent second.  You do not need to worry about the persistence of the flash risk traces, you need to

principally examine the second before the line moves into failure, or where the diagnostics trace shows

that the transition count is still rising.  Once you have corrected all the causes of the line first moving into
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failure then the material at that point will pass the test.  Note, however that lots of flashing close together

will generate a much longer compound failure: the best thing to do is deal with the flashes one at a time

until the material passes the test.

(3) Flash graph persisting after the flash.

4) The diagnostic transition count increased where no obvious flash had occurred – The

diagnostic trace represents the number of transitions seen by the most active 25% of the screen over the

most recent second. Therefore continuous image activity (e.g. localised flashing and rapid movement

within the scene caused by camera pan or zoom etc) can steadily increase the number of transitions that

individual pixels have seen, and when at least 25% of those have seen an extra transition will the

diagnostic count increase. This can be quite trickymaterial to fix, and may only be possible by reducing the

brightness of the image or cut down on the whole area.
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(4) Transition count (light green trace) increased without an obvious transition

5) A flash clearly occurred but the diagnostic trace didn’t increase – The diagnostic trace shows

the number of transitions seen in the last second of material, and transitions older than that will be

discarded. This means that the diagnostic count may not always coincide with an obvious flash.  For

example, a visible transition in an image may not lead to a higher transition count if the pixels that see the

transition are not part of the most active 25%.
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(5) A flash clearly occurred but the diagnostic trace hasn’t increased.

Alternatively, an incoming transition may coincide with an outgoing transition from one exactly second

earlier. When this occurs, the new version 3 analyser inserts a squiggle (see picture with inset) to indicate

that the diagnostic trace has simultaneously gained and lost a transition over the most recent second

between video frames.
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6) The spatial pattern trace remains in the pass zone even though the detected spatial pattern

exceeds contrast and screen area limits – A number of limits have to be exceeded before a detected

spatial pattern can generate a failure. The Advanced Information tab in the example below shows that a

spatial pattern has been detected with 50 cd/m2 contrast (limit 20 cd/m2) and covers 46% screen area

(limit 40%). However, in this example, the system has not generated a failure because motion, caused by

the camera pan and zoom, makes the detected spatial pattern exempt from failure under Ofcom rules.
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7) The diagnostic trace decreased within a few frames after it had increased. Shouldn’t it have

taken one second for the transition to flush out? -- Not necessarily. It is true that the diagnostic trace

monitors transitions over the most recent second but the most active pixels that determine this diagnostic

count are, in most cases, constantly changing. The diagnostic trace will only follow this one-second pattern

if the most active pixels are changing together in phase.

The example below shows the diagnostic trace (light green) increasing from zero to one for a period of only

two frames (around the vertical amber current frame line) before returning to zero.
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8) The system passes a stationary pattern that looks as though it should have failed – Some

patterns that are clearly bar-like in one direction may also possess some local structure in the orthogonal

direction. Alternatively, a pattern may not be sufficiently regular or may not have sufficient contrast

throughout. Any such structure may cause the system to see fewer than 6 light-dark bars or may separate

a provocative pattern into two or more regions. Either of these mechanisms can save a provocative pattern

that would otherwise have failed.

The spatial pattern in the example below passes because of text and foreground objects which break up

the bar-like pattern into smaller irregular regions.
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9) The analyser generates spatial warnings but it’s not obvious where the pattern is! –

Occasionally the spatial trace may appear when there is no obvious spatial pattern present in the video

stream. The example below shows a picture of the sea generating spatial warnings caused by waves in

perspective creating faint, repeating structure. Other candidates for generating unexpected spatial

responses are: landscape in perspective, net curtains and reams of paper. However, it is highly unlikely

that any of these scenes would actually lead to a spatial pattern failure.
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10) Scene Changes (Japanese NAB Analysis only) - When analysing under Japanese NAB

guidelines, it is possible for the flash risk trace to go into failure while the diagnostic trace is still in the

caution zone (see image). This can occur if one of the transitions in the most recent second is classified as

a “scene change” (see bottom entry of the Advanced Information tab) where 80% of the image has seen a

significant luminance transition of 20IRE units or more. When this occurs, the maximum allowable number

of transitions is reduced from 6 down to 3 and, in this example, failure took place when the 4th transition

was detected.
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The Results Menu

Within the Results menu are the controls for navigating the results graphs and thumbnails and playing

back sections of video (only available where images are present – images are only written to the results

files in areas of interest, for example around failures).
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Advance to Next Failure/Caution andGo Back to Previous Failure/Cautionwill perform the same action

as the ‘seek right’ and ’seek left’ arrow buttons under the graph, taking the cursor position to the next or

previous failure/caution area.

The following menu items provide the ability to play back the images in various ways:

Start Replay: Starts playback in real-time from the current position.

Stop Replay: Stops all playback.

Replay one second before and after cursor: Animate the images for one second before and one second

after the current cursor position whilst leaving the graph positioned at the current cursor position. This is

especially useful when you are looking for the causes of a particular failure and need to look at the graph in

detail and yet still see the offending section being played back.

Replaymarked region: Replays from the Start marker to the End Marker. Set marker positions by either

right-clicking on the graph or pressing the Page Up and Page Down keys or by clicking on Set Results Start

and Set Results End in this menu.

In all playbackmodes, the playback will loop when reaching the end (after a small pause). The playback

can be stopped at any time with the Stop Playbackmenu item or button, by clicking anywhere on the

graph, by dragging the seek slider or by opening a new file.
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Licence Terms
This HardingFPA product utilises icons from the Silk icon set at

http://www.famfamfam.com/lab/icons/silk/ and the Fat Cow icon set at http://www.fatcow.com/free-

icons.

http://www.famfamfam.com/lab/icons/silk/
http://www.fatcow.com/free-icons
http://www.fatcow.com/free-icons
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